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   ดหมายขาวสํานักคอมพิวเตอร 
 

ปที่ 8 ฉบับที่ 4 กรกฎาคม - สิงหาคม 2547 

บันทึกจาก 
ผูอํานวยการสํานักคอมพิวเตอร 

ในเดือนสิงหาคมนี้ มหาวิทยาลัยไดรับเรื่องจากกระทรวง
เทคโนโลยีสารสนเทศและการสื่อสาร และสํานักบริการ
เทคโนโลยีสารสนเทศภาครัฐ (สบทร.) ใหประสานการดําเนิน
งาน 2 เรื่อง คือเรื่องที่หนึ่ง ขอความอนุเคราะหรวบรวมขอมูล
ผูบริหารระดับ 8 หรือเทียบเทาขึ้นไป เพื่อจัดทําใบรับรอง
อิเล็กทรอนิกส เรื่องที่สอง ขอเชิญผูประสานงานเขารวมอบรม
การติดตั้งและใชงานใบรับรองอิเล็กทรอนิกส ตามโครงการ 
ใบรับรองอิเล็กทรอนิกสเพื่อขาราชการ ซึ่งจะอบรมในวันที่  
20-21 กันยายน 2547   สํานักคอมพิวเตอรก็จะสงเจาหนาที่
ไปอบรมดวย 
จากหนังสือทั้ง 2 ฉบับ ทําใหทราบวากระทรวงเทคโนโลยี

สารสนเทศและการสื่อสาร กําลังเรงดําเนินการโครงการ 
ใบรับรองอิเล็กทรอนิกสเพื่อขาราชการ เพื่อใหบรรลุตามแผน
ของกระทรวงฯที่จะพัฒนาระบบลายมือชื่อดิจิทัล(Digital 
Signature) แจกจายใหหนวยงานตาง ๆ ภายใน 30 กันยายน 
2547 มีเปาหมายใหได 20,000 ใบรับรองอิเล็กทรอนิกส โดยมี 
สบทร. เปนผูดําเนินการทางเทคนิค  
ใบรับรองอิเล็กทรอนิกสคือการจดทะเบียนผูที่ใชระบบการ

ส่ือสารอิเล็กทรอนิกสอยางเปนทางการเพื่อใหสามารถดําเนิน
ธุรกรรมทางอิเล็กทรอนิกสไดอยางปลอดภัยและถูกตองตาม
ระเบียบราชการ เชน การสงหนังสือราชการผานเครือขาย 
อินเทอรเน็ต  โดยผูที่จดทะเบียนขอใบรับรองอิเล็กทรอนิกสจะ
ไดรหัส 2 รหัส คือกุญแจสาธารณะ (Public key)  เพื่อแจงให
ผูที่ตองการสื่อสารทราบ และจะไดกุญแจสวนตัว (Private 
key) เพื่อดําเนินการรับสงขอมูล 
สํานักคอมพิวเตอรจึงขอใหขอมูลแกผูอยูในขายที่จะได 

ใบรับรองอิเล็กทรอนิกส  เพื่อทราบความเปนมา และใน 
ฉบับหนาเราจะนําส่ิงที่ไดจากการอบรมมาเลาสูกันฟงตอไป  

 
กิจกรรมและบริการ 

 
 เครือขาย Wi-IS 
      

 
ระบบสารสนเทศผานเว็บ

บริการ   

 
 ปฏิทิน มศว  
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เลาสูกันฟงงานเครือขายบัวศร ี

  มหัทธวัฒน รักษาเกียรติศักดิ์ & นคร บริพนธมงคล 
 
ในชวงที่ผานมาเครือขายบัวศรี ไดมีการปรับปรุงเพิ่มเติม

เพื่อเพิ่มประสิทธิภาพการใชงานมากขึ้น  สงผลให คณาจารย 
นิสิต และบุคลากร สามารถใชงานเครือขายบัวศรีไดประโยชน
คุมคา ดังนั้นในวันนี้จะไดเลาสูกันฟงถึงส่ิงตางๆ ที่  สํานัก
คอมพิวเตอร ไดดําเนินการไปแลว ไดแก บริการเครือขาย 
ไรสาย ( Wireless Lan)  การเพิ่มชองทางออกสูอินเทอรเน็ต 
ชองทางที่ 2   และ การแจงปญหาเครือขายผานเว็บ   ส่ิงตาง ๆ 
เหลานี้จะมีประโยชนตอผูใช  ทําใหการใชงานทําไดสะดวกยิ่ง
ขึ้นและยังเพิ่มประสิทธิภาพในการใชงานระบบเครือขายบัวศรี 
และอินเทอรเน็ตโดยรวมดวย 
เครือขาย Wi-IS (Wireless Internet Service) 
ปจจุบันเครือขายไรสาย เปนเครือขายที่กําลังไดรับความ

นิยมเปนอยางมาก  ประกอบกับอุปกรณเครือขายไรสายเริ่มมี
ราคาถูกและซื้อหาใชงานไดงายขึ้น  ในปงบประมาณ 2547 
สํานักคอมพิวเตอรไดเริ่มโครงการนํารองเครือขายไรสาย และ
ไดติดตั้งแลว จํานวน 3 จุด ไดแก สํานักคอมพิวเตอร บริเวณ
ห อ งปฏิ บั ติ ก ารคอมพิ ว เต อ ร  ชั้ น  3 อาคาร  16, สํ านั ก 
หอสมุดกลาง ประสานมิตร ชั้น 3 ซึ่งครอบคลุมบริเวณใชงาน 
ชั้น 2 และ ชั้น 4 บางสวน,  และหอสมุด มศว องครักษ  ชั้น 1 
โดยมาตรฐานของอุปกรณที่ติดตั้งในครั้งนี้ เปนมาตรฐาน 
IEEE802.1g สามารถรองรับการใชงานที่ความเร็ว 54 Mbps 
แตถ าท านใดมีอุปกรณ ที่ เป น  มาตรฐาน  IEEE802.1b ก็
สามารถใชงานได สวนการขยายเครือขายไรสายระยะที่ 2 นั้น
คงจะไมนานเกินรอ  ซึ่งจะไดมีการขยายเครือขาย Wireless 
Lan ใหครอบคลุมทั่วมหาวทิยาลัย  

 

เว็บเพจเครือขาย Wi-IS (Wireless Internet Service) 
http://wireless.swu.ac.th  

 

การใชงานอินเทอรเน็ตชองทางที่ 2 
สํานักคอมพิวเตอรทราบถึงปญหาการใชงานอินเทอรเน็ต 

ของประชาคม ชาว มศว อันเนื่องมาจากการขัดของของเครือขาย 
UniNet    จึงได เพิ่มชองทางออกสูอินเทอรเน็ต ชองทางที่  2  
ขนาด 2 Mbps      ตั้งแตวันที่ 16 มิถุนายน 2547  นอกเหนือจาก
การออกอินเทอรเน็ตผานเครือขาย Uninet    เพื่อใหเครือขาย 
บัวศรีสามารถติดตอกับอินเทอรเน็ตไดตลอดเวลา  ในกรณีที่ link 
ของเครือขาย Uninet  ที่เปนเสนทางหลักเกิดปญหา  
 

 
 

แสดงการใชงานอินเทอรเน็ต ชองทางที่ 2 

การแจงปญหาผานระบบเครือขาย 
จากปญหาที่เกิดขึ้นภายในระบบเครือขายบัวศรี  บางครั้งผูใช

จะไมทราบสาเหตุของปญหาตาง ๆ   ดังนั้นสํานักคอมพิวเตอร 
จึงไดพัฒนาระบบแจงขาวปญหาเครือขาย เพื่อใหสะดวกรวดเร็ว
ในการรับทราบขาวสารเกี่ยวกับเครือขายบัวศรี ไมวาจะเปน
ปญหาในเรื่องของการใชงาน  หรือปญหาระบบเครือขายขัดของ   
สามารถเขาดูไดที่ http://www.swu.ac.th แลว click ที่ขาวเครือขาย
บัวศรี ที่อยูดานลางซึ่งจะเห็นรายละเอียดทั้งหมดของขาวเกี่ยว
กับเครือขายบัวศรี 

 

การพัฒนาระบบเครือขายบัวศรีจะยังไมหยุดเพียงเทานี้ ใน
โอกาสหนาคงไดพบกับงานในกาวตอไปของพวกเรา  ที่จะให
บริการแกผูใชใหสามารถใชงานเครือขายบัวศรีและอินเทอรเน็ต
ไดสะดวกและรวดเร็วยิ่งขึ้น  
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บริการระบบสารสนเทศนิสิตผานเว็บ 

  ไพโรจน ผาสุวรรณ & พรทิพย พงษสวัสดิ์ 
 
จากฉบับที่ แล ว    เราได แนะนํ าทุกท านให ได รูจั กกับ  

ระบบสารสนเทศมหาวิทยาลัย SUPREME2004   ในสวน
ของ ระบบลงทะเบียนนิสิต  ซึ่งก็คิดวาหลาย ๆ ทานคงไดเขาไป
สัมผัสและใชบริการกันบางแลว   ในฉบับนี้   เรามีบริการใหมที่
จะขอแนะนําให  คณาจารย  และนิ สิต   ทุกทาน  ได เขาไป 
ใชบริการเพื่อการสอบถามขอมูล ในเรื่องตาง ๆ  ผานเว็บ   
นั่นก็คือ  ระบบสารสนเทศนิสิต  ซึ่งคณาจารย และนิสิต 
ทุกทานสามารถใชบริการโดยการใช Buasri ID ของตนเอง  ซึ่ง
จะสามารถใชบริการไดตามสิทธิและภาระหนาที่ของแตละ
บุคคลดังนี้ 

 
เว็บบริการระบบสารสนเทศนิสิต   
http://supreme.swu.ac.th 

นิสิต 
บริการ สอบถาม/ตรวจสอบ ขอมูลตางๆ ไดแก 

• ประวัตินิสิต  แสดงชื่อ นามสกุล ที่อยู ชื่ออาจารยที่ปรึกษา 
• ตารางเรียนภาคการศึกษาปจจุบัน  แสดงหองเรียน   

วัน-เวลา  อาจารยผูสอน  
• ตารางสอบ  เพื่อเปนการเตรียมตัวลวงหนาวาสอบเมื่อใด 
• ผลการลงทะเบียนเรียน แสดงรายวิชา ตอนที่ที่ลงทะเบียน  

ผลการลงทะเบียนและผลการชําระเงินคาธรรมเนียม 
การศึกษา 

• ผลการเรียนในภาคการศึกษาที่ผานมา ตั้งแตเขาศึกษา
จนถึงภาคเรียนปจจุบัน    

• หลักสูตรการศึกษาของตนเอง  เพื่อดูวาเรียนมาแลว
เทาใด  เหลืออีกกี่รายวิชาจึงจะจบหลักสูตร 

• หลักสูตรกิจกรรม แสดงรายการกิจกรรมที่เขารวม   
รวมทั้งตรวจสอบการผานหลักสูตรกิจกรรม 

 

อาจารย 
บริการขอมูลในการบริหารและจัดการเรียน – การสอน  

• ตรวจสอบความถูกตองของขอมูลตนเอง (profile) 
• ขอมูลนิสิตที่ลงทะเบียนเรียนในรายวิชาที่ทานสอน  

(ตารางสอน)  
• สามารถติดตอนิสิตผานทาง E-mail เปนรายบุคคล หรือ

ทั้งกลุม เชน การนัดสงงาน  การแจงผลการสอบ  การยาย
หองเรียน  ฯลฯ 

• สามารถสอบถามขอมูลตารางสอน - ตารางสอบ  พรอม
พิมพรายงานเชน ทบ.30 (ตารางสอน) ตารางหองเรียน  
ตารางหองสอบ 

• ภาระงานสอน  แสดงรายวิชาที่สอนและคา SCH 
• ผลการเรียนของนิสิตในรายวิชาที่สอน 

 
อาจารยที่ปรึกษา 
บริการสอบถามขอมูลของนิสิตที่ดูแล เพื่อชวยใหการดูแลและ

ติดตามนิสิต สะดวก รวดเร็ว มากยิ่งขึ้น   
• แสดงรายชื่อนิสิตที่ดูแล  แจงเตือนกรณีผลการเรียนมี

ปญหาเชน เกรดเฉลี่ยต่ํากวา 2.00 (เตรียม Pro)  
• แสดงสถานการณลงทะเบียนเรียนในภาคเรียนปจจุบัน 
• สอบถามขอมูลเพิ่มเติมของนิสิต เชน ตารางเรียน-ตาราง

สอบ  ผลการเรียน  ผลการเขารวมกิจกรรม ผลการผาน 
กิจกรรม  เพื่อดูแนวโนมการสาํเร็จการศึกษา 

• การสงผลการผานกิจกรรมของนิสิต ที่จะสําเร็จการศึกษา 
ขอเชิญชวนนิสิต  อาจารยผูสอน และอาจารยที่ปรึกษา  

สัมผัสและใชบริการ ระบบสารสนเทศนิสิต 
ผานอินเทอรเน็ต  ไดที่  http://supreme.swu.ac.th 
และขอรับ Buasri ID ไดที่ สํานักคอมพิวเตอร 
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ไวรัสวายรายบนอินเทอรเน็ต 
  วิโรจน เตี๋ยอนุกูล 

 
ไวรัสเปนภัยของคอมพิวเตอรที่ รูจักกันมาตั้ งแตสมัยที่ 

อินเทอรเน็ตยังไมไดเปนที่นิยมกัน มันถูกกลาวถึงมาโดยตลอด
เลย ตัวอยางงายๆ ที่พบบอยๆ ก็อยางเชน Macro Virus ที่ติดใน
โปรแกรม word ที่คุณใชพิมพงานทั่วไป มันจะทําใหเอกสารของ
คุณรวนไป และใชโปรแกรมเปดอานหรือแกไขตอไมได เปนตน 
ยิ่งเมื่ออินเทอรเน็ตไดเขามาสูชีวิตประจําวันของเรามากขึ้นมี 
การใชงานกันอยางแพรหลายก็ยิ่ง  ทําใหมีการสงขอมูลถึงกันได
สะดวกรวดเร็วขึ้ น  ผลที่ ตามมาก็คือ  ทํ าให เจ าไวรัสตั วดี  
(นาจะเรียกวา”ไวรัสตัวราย”จะเหมาะสมกวา) สามารถแพร
กระจายไดอยางรวดเร็วขึ้นตามไปดวย ป จ จุ บั น จึ ง มี ไ ว รั ส 
รูปแบบตาง ๆ แปลก ๆ ใหม  ๆ มากมายออกมาอาละวาด 
หลอกหลอนใหเราตกใจกลัวไปตาม ๆ กัน 
ปญหาเกี่ยวกับไวรัสและแนวทางการบริหารจัดการ  
ไวรัสที่ โดงดังมาก ๆ ในชวงเดือน สิงหาคม พ.ศ. 2547 ที่ 

ผานมาคือไวรัสชื่อ W32.Sasser.Worm   ซึ่งเปนหนอน ที่ออก
อาละวาดไปทั่วมหาวิทยาลัย สรางความเสียหายใหแกระบบ 
ทําใหเครือขายบัวศรีทํางานชาลงอยางมาก  จนทําใหระบบ
สําคัญของมหาวิทยาลัย เชน ระบบสารสนเทศของมหาวิทยาลัย
ใชงานไมได   
สํานักคอมพิวเตอรจึงไดดําเนินการแกไขกันอยางเรงดวน 

จนกลับคืนสูสภาวะปกติได  โดยเฉพาะระบบปฏิบัติการที่ไดรับ
ผลกระทบก็คือ Windows 2000 และ Windows XPสาเหตุของ
การระบาดมาจากเครื่องคอมพิวเตอร ที่ไมไดติดตั้งโปรแกรม 
Antivirus และการอัพเดท Windows ใหทันสมัย 
หนอน หรือ Worm คืออะไร 

 หนอนเปนโปรแกรมที่ถูกออกแบบมาใหมีความสามารถใน
การทํ าสําเนาตัวเองด วยโคดที่ อยู ในตัวมันเองโดยอิสระ    
ไมตองรอการเรียกใชงานจากผูใช  ซึ่งแตกตางจากไวรัส    แต
ลักษณะโดยทั่วไปจะคลายกับไวรัสนั่นเอง    หนอนสามารถ 
แพรกระจายตัวเองจากเครื่องคอมพิวเตอรเครื่องหนึ่งไปยังอีก
เครื่องหนึ่ง   โดยอาศัยระบบเครือขายแพรกระจายไดอยาง 
รวดเร็วและทําความเสียหายรุนแรงกวาไวรัสมาก    
จากรายงานสถิติพบวาหนอนสามารถแพรกระจายไปบน

ระบบเครือขายที่มีคอมพิวเตอรมากกวา 5,000 เครื่องภายใน
ระยะเวลาเพียงไมกี่ชั่วโมงเทานั้น (มันสามารถทําความเสียหาย
ตอระบบไดจากภายใน ก็เหมือนกับหนอนที่กัดกินผลไมจาก 
ภายใน) หนอนมักจะติดกับโปรแกรมที่เรานิยมใชกันทั่วไป   เชน 
โปรแกรมสําหรับ รับ-สง อีเมล (MS Outlook 97/98/2000 หรือ 
Outlook Express) เพื่อสงตัวเองไปยังผูรับอีเมลคนอื่นๆ ที่มีชื่อ

อยูในรายการ Address Book โดยหนอนจะแนบตัวเองไปกับ
อีเมลที่ถูกสงออกไปและอาศัยชองโหวในซอฟตแวร เชน ชองโหว
ของ Outlook Express เปนตน   หรือมักจะแพรกระจายผาน
โปรแกรมสนทนา IRC (Internet Relay Chat) อยูบอยๆ 
บริการติดตั้งระบบปองกันไวรัส 
สํานักคอมพิวเตอรไดดําเนินการจัดทําระบบปองกันไวรัส 

เพื่ อใหบ ริการกับเครื่องคอมพิ วเตอรที่ เชื่อมตอกับระบบ 
เครือขายบัวศรี  
 การติดตั้งโปรแกรม AntiVirus 

เป นระบบป องกั น ไวรัสประกอบไปด วย  Trend Micro 
OfficeScan Corporate Edition (OfficeScan) จะทํ าหน าที่ ใน
การตรวจจับไวรัสและ Update Virus signature ใหอัตโนมัติ 
ทุกชั่วโมง ระบบปองกันไวรัสนี้สามารถใชงานไดกับระบบ 
ปฏิบัติการ Windows 98 และ Internet Explorer 5 เปนตนไป  
 การติดตั้ง Software Update Service (SUS Server) 

ทําหนาที่ในการติดตั้ง Security Patch (Hot fix) และ Service 
Pack ใหอัตโนมัติ  สามารถใชงานไดกับระบบปฏิบัติการ 
Windows 2000 SP3 เปนตนไป 

ทานสามารถใชบริการนี้ไดที่  http://www.swu.ac.th หัวขอ  
ขาวเครือขายบัวศรี > การติดตั้งระบบปองกันไวรัส  
เพื่อเปนการปองกันการระบาดไวรัสคอมพิวเตอร ดังนั้นเครื่อง

คอมพิวเตอรทุกเครื่องจําเปนตองติดตั้งโปรแกรม Antivirus และ 
Software Update Service 
สามขั้นตอนที่ชวยใหคุณแนใจวาคอมพิวเตอรของ
คุณไดรับการปองกันแลว 
ขั้นตอนที่ 1 ใชอินเทอรเน็ตไฟรวอลล Windows XP ขึ้นไป 
ขั้นตอนที่ 2 ติดตั้ง Software Update Services (SUS) เพื่อ

อัพเดท Windows ใหทันสมัยอยูเสมอ 
ขั้นตอนที่ 3 ติดตั้งซอฟตแวรปองกัน (Antivirus OfficeScan) 

สรุป 
"ไวรัสคอมพิวเตอรจะไมสามารถทําลายขอมูล และสรางความ

เสียหายตอระบบได หากผูใชคอมพิวเตอรทุกคนมีวินัยในการใช
งานระบบคอมพิวเตอร"  
ขอมูลอางอิง 

http://www.microsoft.com/      
     http://thaicert.nectec.or.th/ 

http://www.trendmicro.com/  
     http://www.symantec.com/ 
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การจัดการเรียนการสอนออนไลนดวยระบบ Open Source LMS “ATutor”:  
กรณีศึกษาของมหาวิทยาลัยศรีนครินทรวิโรฒ 

 สุณี  รักษาเกียรติศักดิ์  
 
ในจดหมายข าวฉบั บส งท ายป งบประมาณ  2547 นี้  

ขอนําเสนอบทคัดยอผลงานวิจัย เรื่อง การจัดการเรียนการสอน
ออนไลนด วยระบบ  Open Source LMS ”ATutor” : กรณี
ศึกษาของมหาวิทยาลัยศรีนครินทรวิโรฒ  โดย ผศ.ดร.สุณี 
รักษาเกียรติศักดิ์, ดร.ขนิษฐา  รุจิโรจน, อ.วราภรณ วิยานนท, 
อ.สาโรช เมาลานนท  ที่นําเสนอในการประชุมวิชาการวิจัย
ส ถ าบั น  ป ระจํ าป  2547 วั น ที่  10 – 11 กั น ย ายน  2547  
ณ ศูนยประชุมสถาบันวิจัยจุฬาภรณ กรุงเทพมหานคร ดังนี้   
บทคัดยอ 
ในปจจุบันหนวยงานการศึกษาไดตื่นตัวกันเปนอยางมากใน

การใชเทคโนโลยีสารสนเทศและการสื่อสารหรือไอซีที (ICT) ใน
การจัดการเรียนการสอนแบออนไลน หรือ e-learning  ซึ่งเปน
ยุทธศาสตรหนึ่งของการพัฒนาองคกรสูสังคมฐานความรู ในการ
ดําเนินการดังกลาวจําเปนอยางยิ่งที่จะตองหาระบบในการจัด
การเรียนแบบออนไลน (Learning Management System หรือ 
LMS)  มาใช  ระบบเหลานี้มีทั้งที่เปนระบบเชิงพาณิชยที่ตองเสีย
คาบริการในการใชงานรายป  และระบบแบบ Open source  
ซึ่งไมมีคาใชจายดานซอฟตแวร และหนวยงานสามารถนํามา
ป รับ แต งให เข ากั บ สภ าพ แวดล อม ของหน วย งาน ได   
มหาวิทยาลัยศรีนครินทรวิโรฒไดทดลองปรับแตงใชระบบ Open 
source LMS ชื่อ  “ATutor” ของมหาวิทยาลัยโทรอนโท ประเทศ
แคนาดา (http://www.atutor.ca) ตั้งแตภาคการศึกษาที่  1/2546 
(มิถุนายน  2546) ใน  version 1.1 และพบวาเป นระบบที่ มี 
องคประกอบของระบบการจัดการเรียนการสอนออนไลนที่
ครบถวน ติดตั้งงาย ใชงานงาย และมีความเชื่อถือไดสูง  ระบบ
ได มีการพัฒนาอยางตอเนื่องและรวดเร็ว  โดยในปจจุบัน 
(สิงหาคม 2547)  ระบบ ATutor ไดเผยแพรใหสาธารณชนไดใช
ใน version 1.4.1 แลว  และมหาวิทยาลัยศรีนครินทรวิโรฒได
ปรับเปล่ียนระบบเปน version 1.4.1 ในภาคการศึกษาที่ 1/2547  
นอกจากนั้นแลวมหาวิทยาลัยศรีนครินทรวิโรฒยังไดดําเนินการ
วิจัยและพัฒนาปรับแตงการใชงานเพิ่มเติม เชน การเชื่อมตอ
ระบบ ATutor กับฐานขอมูลของมหาวิทยาลัย การพัฒนาระบบ
การวิเคราะหขอสอบใน ATutor เปนตน ตลอดจนการจัดทํา
เอกสารประกอบการใชงานและเอกสารประกอบการอบรม  และ
การเขียนบทความวิชาการเพื่อเปนแรงกระตุนอยางตอเนื่อง    
อีกทั้งยังไดดําเนินการถายทอดและแลกเปลี่ยนประสบการณ 

ในการใชงาน   เพื่อสรางเครือขายการใชงานรวมกันระหวาง 
หนวยงานการศึกษาในประเทศไทยใหเปนอีกทางเลือกหนึ่งของ
การใชระบบ LMS แบบ Open Source ที่ ไม มีคาใชจายดาน
ซอฟตแวร   ไดจัดโครงการสัมมนาปฏิบัติการขึ้นครั้งแรกในวันที่ 
24-25 มกราคม 2547 โดยจัด 2 หลักสูตรพรอมกัน คือ หลักสูตร 1: 
การใชระบบ ATutor สําหรับอาจารยผูใชระบบ และ หลักสูตร 2: 
การติดตั้งและดูแลระบบ ATutor สําหรับผูติดตั้งดูแลระบบ   รับ
หลักสูตรละ 30 คน  จัดรุนที่ 2 ในวันที่ 1–2 เมษายน 2547 และ
รุนที่ 3 ในวันที่ 10-11 กรกฎาคม 2547  โดยในรุนที่ 3 มีการเพิ่ม
หลักสูตร 3: การปรับแตงระบบ ATutor ดวย PHP และ MySQL  
สําหรับผูที่ผานหลักสูตร 1 หรือหลักสูตร 2 มาแลว และจัดตอ
เนื่องในวันที่ 12-14 กรกฎาคม 2547   ในการจัดในรุนที่ 2 และ 
รุนที่  3 มีผูสมัครเขารวมโครงการเกินกวาจํานวนที่จะรับได   
มีผูเขารวมโครงการทั้งส้ินในการจัดทั้ง 3 ครั้ง จํานวน  248 คน 
จากหนวยงานการศึกษาทั้งส้ิน 100 หนวยงานทั่วประเทศ  หลาย
หนวยงานไดมีการติดตั้งระบบ ATutor ในหนวยงานและมีการ 
อบรมบุคลากรในหนวยงานแลว  หลายหนวยงานอยูในระหวาง
การเตรียมการเนื่องดวยตองรองบประมาณในปถัดไป  คาดวาใน
ปงบประมาณ 2548 จะมีหนวยงานที่ผานการอบรมดําเนินการ
ติดตั้งและใชงานระบบ  ATutor กันมากขึ้น  แตอยางไรก็ดีการ
เติบโตที่ยั่งยืนตองอาศัยนโยบายและวิสัยทัศนของผูบริหาร
หนวยงานอยางมากที่จะเปนผูผลักดันใหการดําเนินงานบรรลุ
เปาหมาย 

 

ขอเชิญชวนคณาจารย/นิสิต มาใชงานระบบ ATutor ไดที่ 
http://course.swu.ac.th/browse.php 
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เทคนิคการนํารูปภาพประกอบจดหมายขาว 

  สมบุญ อุดมพรยิ่ง & พีระ แพทยประเสริฐ 
 
ปจจุบันการจัดทําตนฉบับจดหมายขาว หรือวารสาร ทําได

งายกวาแตกอนมาก เนื่องจากมีการนําเทคโนโลยีคอมพิวเตอร
มาชวยในการทํางานมากขึ้น เชน ใชโปรแกรม Microsoft Word  
ในการจัดทําตนฉบับ 
จากประสบการณ ในการจั ดทํ าจดหมายข าวสํ านั ก

คอมพิวเตอรมาประมาณเกือบ 3 ป  การจัดทําตนฉบับจดหมาย
ขาว โดยใชโปรแกรม Microsoft Word   สวนใหญมักจะมีรูปภาพ
ประกอบบทความ   เพื่อทําใหผูอานไดเกิดความสนใจและเขาใจ
ในเนื้อหาบทความมากยิ่งขึ้น   การนํารูปภาพมาประกอบในบท
ความนั้น ไมยาก   สามารถใชคําส่ังคัดลอกและวาง หรือการนํา
รูปภาพมาแทรกในเนื้อหา   แตเคยมีใครสังเกตบางไหมวาทําไม
ขนาดของแฟมขอมูลถึงไดมีขนาดใหญขึ้นเมื่อเทียบกับแฟม 
ขอมูลที่มีแตเนื้อหาอยางเดียว  และจะมีเทคนิคอยางไรในการที่
จะชวยใหแฟมขอมูลดังกลาวมีขนาดเล็กลงได    
ทําไมแฟมขอมูลบทความที่มีรูปภาพประกอบจึงมี
ขนาดใหญ 
การนํารูปภาพมาประกอบเนื้อหาหรือบทความนั้น  สวนใหญ

มักจะใชวิธีการคัดลอกและวางรูปภาพตนฉบับ  หรือใชคําส่ัง
แทรก (Insert > Picture) รูปภาพตนฉบับลงในเนื้อหา   บางครั้ง
รูปภาพที่ไดมีขนาดไมตรงกับความตองการ ก็ทําการขยาย/ยอ
ขนาดดวยการคลิกที่รูปภาพ และลากมุมของรูปภาพขึ้นลง เพื่อ
ขยาย/ยอขนาดลง  ถึงแมวาการทําดวยวิธีการดังกลาวจะได 
รูปภาพขนาดที่ตองการก็จริง      แตในความเปนจริงแลวขนาด
ของแฟมขอมูลรูปภาพไมไดเพิ่มหรือลดตามไปดวย   ทําให 
แฟมขอมูลบทความจึงมีขนาดใหญ ตามแฟมขอมูลรูปภาพที่ใช
ประกอบบทความดังกลาว 

 
เทคนิคการลดขนาดแฟมขอมูลรูปภาพ 
สําหรับโปรแกรม Microsoft Word 9X, 2000 นั้น ยังไมมีฟงก

ชั่นในการชวยลดขนาดแฟมขอมูลรูปภาพ  จึงจําเปนตองใช
โปรแกรมตัวอื่น มาชวยในการลดขนาดขอมูลรูปภาพลง  เชน 
Photoshop แตสําหรับโปรแกรม Microsoft Word  XP 
ขึ้นไป จะมีฟงกชั่นในการบีบอัดรูปภาพใหมีขนาดเล็กลงได 
 โปรแกรม Photoshop  

เปดแฟมขอมูลรูปภาพผานโปรแกรม Photoshop และเลือก 
เมนู  Insert > Picture > Image Size… ดังรูป 

 
จะปรากฏจอภาพเพื่อกําหนดขนาดของรูปภาพตามตองการ 

ไดที่ Pixel Dimensions ซึ่งจะแสดงขนาดของแฟมขอมูลรูปภาพ
ใหเห็นมีหนวยนับเปน Kbyte  และกดปุม OK  

 
หลังจากนั้นใหทําการบันทึกแฟมขอมูลรูปภาพเปนชื่อแฟม 

ขอมูลรูปภาพใหม  เพื่อนําไปแทรกลงในบทความตอไป 
 โปรแกรม Microsoft Word  XP 

เปดแฟมขอมูลรูปภาพผานโปรแกรม Microsofrt Word XP 
คลิกที่รูปภาพ แลวเลือกเมนู Format > Picture > Picture > 
Compress..  จะปรากฏจอภาพ ดังรูป 

 
เลือก Options เปน Compress Picture  และกดปุม OK   

พรอมทั้งทําการ Save แฟมขอมูล  โปรแกรมจะทําการบีบอัดรูป
ภาพ ทําใหแฟมขอมูลที่จัดเก็บมีขนาดเล็กลง  
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ปฏิทิน มศว : ระบบบริการใหมผานเว็บ 
  สุวิมล คงศักดิ์ตระกูล 

 
ในเว็บไซตใหมของมหาวิทยาลัย ซึ่งไดมีการเปดตัวไปแลว

ตั้งแตวันที่ 28 มิถุนายน ที่ผานมานั้น นอกจากจะพบกับรูปแบบ
และการนําเสนอสาระเนื้อหาใหม ๆ ที่เปล่ียนไปจากเดิมแลว 
บนโฮมเพจใหมจะมีการเนนในเรื่องการประชาสัมพันธขาวและ
กิจกรรมตาง ๆ ของมหาวิทยาลัย เพื่อใหเปนส่ือกลางในการ
แจงขาวความเคลื่อนไหวตาง ๆ ที่เกิดขึ้นในมหาวิทยาลัย และ
เผยแพรสูประชาคมของ มศว และบุคคลทั่วไปที่ไดเขามาแวะชม
เว็บไซตของมหาวิทยาลัย ในสวนของกิจกรรมจะมีการนําเสนอใน
รูปแบบที่เรียกวา ปฏิทินกิจกรรม ซึ่งเปนการประกาศใหทราบ
วาในวันหนึ่ง ๆ  มีกิจกรรมอะไรเกิดขึ้นบาง เวลาใด และจัดขึ้น ณ 
สถานที่แหงใด ประกาศดังกลาวเปนสวนหนึ่งของขอมูลที่มีอยูใน
ระบบที่เรียกวา ปฏิทิน มศว ซึ่งเปนระบบบริการผานเว็บระบบ
ใหมที่ทีมงานเว็บของมหาวิทยาลัยไดพัฒนาขึ้น เพื่อใหเปนแหลง
รวมและนําเสนอกําหนดการจัดกิจกรรมทั่วไปที่หนวยงานใน
มหาวิทยาลัยจัดขึ้น นอกจากนั้นยังมีการนําเสนอขอมูลกําหนด
การปฏิทินการศึกษาทั้งในระดับปริญาตรีและบัณฑิตศึกษา
ตามประกาศของมหาวิทยาลัย 
ระบบปฏิทิน มศว 
ระบบปฏิทิน มศว (SWU Calendar) เปนบริการผานเว็บที่

สํานักคอมพิวเตอรไดพัฒนาขึ้นเพื่อเปนเครื่องมือใหบริการดาน
การประกาศแจงปฏิทินกิจกรรมและปฏิทินการศึกษาผานเว็บ ซึ่ง
จะชวยใหคณาจารย บุคลากร นิสิต รวมทั้งผูสนใจทั่วไป ไดรับ
ขาวและกําหนดการจัดกิจกรรมตาง ๆ ของมหาวิทยาลัยไดอยาง
สะดวกและรวดเร็ว นับเปนอีกชองทางหนึ่งของการสื่อสารและ
เผยแพรประชาสัมพันธของมหาวิทยาลัยเพื่อไปสูกลุมเปาหมาย
ทั้งภายในและนอกมหาวิทยาลัยโดยผานเครือขายอินเทอรเน็ต 
บริการนี้อยูที่ใด 
ผูสนใจสามารถเขาใชระบบงานปฏิทิน มศว ไดโดยไปที่ 

calendar.swu.ac.th   หรือ จากโฮมเพจของมหาวิทยาลัย
คลิกที่หัวขอ ปฏิทินกิจกรรม ซึ่งเปนลิงคที่พาไปยังปฏิทิน มศว 

  ปฏิทินกิจกรรม 
ในหนาแรกจะแสดงรายการกําหนดการกิจกรรมลาสุด 6 รายการ 

โดยจะแสดงวันที่จัดกิจกรรม เวลา หัวขอ สถานที่จัดกิจกรรมและ
เบอรโทรศัพทเพื่อการติดตอสอบถามรายละเอียดเพิ่มเติม 
เพื่ออํานวยความสะดวกแกผูเขาชม ระบบไดจัดเตรียมกลุม

เมนูเพื่อแสดงปฏิทินกิจกรรมออกเปน ปฏิทินกิจกรรมประจําวันนี้ 
(Today), ปฏิทินกิจกรรมวันพรุงนี้ (Tomorrow), ปฏิทินกิจกรรม
สัปดาหนี้ (This Week) และปฏิทินกิจกรรมสัปดาหหนา (Next 
Week) 

ผูที่ไดรับมอบหมายใหเปนผูดูแลเว็บของหนวยงานตาง ๆ 
ที่แจงช่ือไวกับทางสํานักคอมพิวเตอรในระบบ SWU 
WebHelp จะไดรับสิทธิ์ในการลงประกาศในปฏิทินกิจกรรม
ของมหาวิทยาลัย ขาวที่สงมานั้นจะถูกนําขึ้นเผยแพรในสวน
พื้นที่ “ปฏิทินกิจกรรม” ในโฮมเพจของมหาวิทยาลัยและใน
เว็บไซต “ปฏิทิน มศว”  
 ปฏิทินการศึกษา 

ผูสนใจสามารถเขาดูปฏิทินการศึกษาโดยคลิกเลือกจากเมนู
ดานซายมือในหัวขอ ปฏิทินการศึกษา และสามารถ Download 
เอกสารปฏิทินการศึกษาในรูปแบบ PDF File ทั้งระดับปริญญาตรี
และบัณฑิตศึกษา โดยในหนาแรกของปฏิทินการศึกษาระบบจะ
แสดงรายการตามเดือนปจจุบัน และแยกแสดงของระดับ
ปริญญาตรีและบัณฑิตศึกษา 
เพื่ออํานวยความสะดวกแกผูเขาชม ระบบไดจัดเตรียมกลุม

เมนูเพื่อแสดงปฏิทินกิจกรรมออกเปน กิจกรรมประจําเดือน (This 
Month) และประจําภาคการศึกษา (This Semester) 
 การคนหากําหนดการกิจกรรม 

ผูสนใจสามารถคนหาและดูกําหนดกิจกรรมได 2 วิธี ดังนี้ 
วิธีที่ 1 โดยพิมพ keywords ลงในกลองคนหา แลวคลิก
เลือกวาตองการคนจากปฏิทินการศึกษาหรือ ปฎิทินกิจกรรม 

วิธีที่ 2 โดยคลิกเลือกเดือนและวันที่ตองการจากปฏิทินที่อยู
ทางซายมือ  
ขอเชิญชวนบุคลากรและนิสิต มศว สัมผัสและทดลอง

ใช ปฏิทิน มศว ไดที่ calendar.swu.ac.th  
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อานดีดี   มีรางวัล 
http://cc.swu.ac.th/ 

ขาวกิจกรรมและบริการ 
สํานักคอมพิวเตอร 

ประกันคุณภาพการศึกษา  
ในวันอังคารที่ 24 สิงหาคม 2546  สํานักคอมพิวเตอรไดรับ

การตรวจประกันคุณภาพการศึกษาภายใน ประจําปการศึกษา 
2546 โดยคณะกรรมการประเมินคุณภาพการศึกษาภายใน มี 
ผศ.กิตติมา สังขเกษม เปนประธานกรรมการ    ไดศึกษาและ
ตรวจสอบขอมูล  พรอมทั้งเขาเยี่ยมชมสถานที่ปฏิบัติงานและ
การใหบริการภายในสํานักคอมพิวเตอร  และใหขอเสนอแนะ 
เพื่อใหสํานักคอมพิวเตอรนําไปปรับปรุงตอไป 

 
การเยี่ยมชมและศึกษาดูงาน  
เมื่อวันที่ 20 สิงหาคม 2547 คณะนิสิต ลงทะเบียนเรียนใน 

รายวิ ชา  บส  352 เทคโนโลยี การสื่ อสารข อมู ล   ภาควิ ชา
บรรณารักษและสารสนเทศศาสตร เขามาศึกษาดูงานเกี่ยวกับ
ระบบเครือขายและการบริหารจัดการระบบเครือขายของ มศว 
จํานวน 12 คน 

โครงการอบรมคอมพิวเตอร 
สํานักคอมพิวเตอรไดจัดอบรมโครงการบริการวิชาการดาน

คอมพิวเตอร  ดูรายละเอียดที่ http://cc.swu.ac.th/training/ 
• ครั้งที่ 49 4 สิงหาคม  ถึง 10  กันยายน 2547  

 สําหรับนิสิตทุกระดับ  
• ครั้งที่ 50  13 สิงหาคม  ถึง 17 กันยายน 2547 

 สําหรับบุคลากร 
• โครงการอบรมสําหรับผูดูแลเว็บของมหาวิทยาลัย 

 22 กรกฎาคม  ถึง 8 กันยายน 2547 

โครงการอบรมปฏิบัติการ 
สํานักคอมพิวเตอรจัดโครงกาอบรมปฏิบัติการ เรื่อง การจัด

การเรียนแบบออนไลนดวยระบบ  Open Source LMS “ATutor”  
รุนที่ 3   ระหวางวันที่   10  -  14  กรกฎาคม   2547  มีจํานวน 
ผูเขาอบรมทั้งส้ิน   106  คน    ใน  3   หลักสูตร  ดังนี้ 

หลักสูตร เรื่อง ผูเขาอบรม 
1 การใชระบบ ATutor 40 คน 
2 การติดตั้งและดูแลระบบ  ATutor 32 คน 
3 การปรับแตงระบบ ATutor  34 คน 

ดวย PHP และ MySQL 

 
ภาพพิธีเปดการอบรม ATutor  รุนที่ 3 

สํานักคอมพิวเตอรจะจัดโครงการอบรมปฏิบัติการ เรื่อง การ
จัดการเรียนแบบออนไลนด วยระบบ   Open Source LMS 
“ATutor” รุนพิเศษ  ระหวางวันที่  18 - 19 กันยายน 2547   
สําหรับศึกษานิเทศน ครู หรือ บุคลากรทางการศึกษา 
และรุนที่  4  ระหวางวันที่ 20 - 21 พฤศจิกายน 2547 

 จะเปดอบรม หลักสูตร 1 และหลักสูตร 2 
ดูรายละเอียดที่ http://cc.swu.ac.th/training/ 

บุคลากร 
นางสาวกุลยา  แสงไสว เจาหนาที่บริหารงานทั่วไป 
พนักงานชั่วคราว  ลาออกเมื่อวันที่ 9 สิงหาคม 2547 

นายชัยวัฒน  ชางกลึง  นักวิชาการคอมพิวเตอร  
พนักงานมหาวิทยาลัยใหม บรรจุเมื่อวันที่ 1 กันยายน 2547 

อานดีดี  มีรางวัล 
รายชื่อผูไดรับรางวัลประจําจดหมายขาวปที่ 8 ฉบับที่ 3 
1. นายอุรุพงษ  สรอยสะอาด คณะพลศึกษา 
2. นางสาวสุรียพร หลออุดมทรัพย คณะพลศึกษา 
    มารับรางวัลไดที่สํานักคอมพิวเตอร ชั้น 4 อาคาร 16  

ภายในวันที่ 20 กันยายน 2547  

 


